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Chapter 1  - Introduction

Wavelink® AvalancheMobility Center™ (AvalancheMC) is a remote client management system that is designed to distribute
software and configuration updates tomonitored devices, including Honeywell computers with Microsoft®Windows®CE or
Windows Mobile®. Additionally, the AvalancheMC Consolemay provide support for other devices on a network at the
discretion of the system administrator.
Avalanche uses amulti-tier software architecture:

l AvalancheMobility Center Console (AvalancheManagement Console in previous versions)
l AvalancheMobile Device Server (Avalanche Agent in previous versions)
l Avalanche Enabler
l Avalanche Remote Control (optional component)

AvalancheMobility Center Console and the AvalancheMobile Device Server run on a desktop PC.
Avalanche Enabler runs on themonitored devices.
This document contains a brief overview of AvalancheMC and how Honeywell computers can bemanaged by AvalancheMC.
Honeywell provides additional functionality for mobile computers using AvalancheMC. This additional functionality is
discussed in this reference guide.
This document also explains the functioning of theWavelink Avalanche Enabler running on amobile device.
This document assumes the user has a basic familiarity with theWavelink AvalancheMC system andMicrosoft Office
Windows terms and graphical standards. For detailed and technical information for the AvalancheMC Console running on a
desktop PC, refer to theWavelink AvalancheMobility Center User’s Guide. This document is available for download from the
Wavelink website, www.wavelink.com.
eXpress Config is an Honeywell value-add component for integration with the AvalancheMC Console. eXpress Config
enables the system administrator to create software package files including software configuration parameters. These
packages are compatible with the AvalancheMC Console and theMobile Device Server downloads these packages to the
mobile devices. Contact Technical Assistance for eXpress Config availability.
eXpress Config also allows a user to print configuration bar codes for amobile computer. The bar codes can be scanned by the
eXpress Scan utility on themobile device to provide initial configuration.
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The Avalanche Enabler Process
In the typical installation, the Honeywell computer, or mobile device, is connected wirelessly to an access point.
The access point is then connected via a wired network to the PC running the AvalancheMobile Device Server.
The Avalanche Enabler, running on themobile computer, initiates communication with theMobile Device Server.
This occurs automatically following amobile device reboot.
Once a connection is made with aMobile Device Server, the Enabler can be configured to control the wireless and network
settings of themobile device. The Enabler can also receive downloads, from theMobile Device Server, of any software
packages made available by the system administrator.
TheMobile Device Server PC records the date and time of the contact and reviews the software load and configuration
settings (wireless and network settings and Terminal Emulation parameters) on the Honeywell mobile device. If there are any
software updates or configuration setting changes scheduled for themobile device, the update is performed at this time.
Once connected to the AvalancheMobile Device Server, themobile device Enabler continues running in the background,
monitoring and processing updates and system information as needed. Themonitoring is performed by a separate application,
Monitor.exe, which is installed as part of the Enabler CAB file. TheMonitor executable is responsible for locating the
AvalancheMobile Device Server and processing all updated information. This information can be configured by the system
administrator using the AvalancheMC Console application and then sent to theMobile Device Server, and then to themobile
computer.
Once the Enabler Monitor receives the data it will apply all new settings, install all software, and provide the user with details,
including any reboots that are needed.
For Honeywell packages, theMonitor application downloads package files to the RMU folder on themobile device’s persistent
storage card. TheMonitor application then launches the RemoteManagement Utility (RMU). The RMU performs the updates
for the Honeywell packages. The RMU is also launched during bootup to restore the package’s configuration settings.
Additional functionality of the Enabler can be accessed through a password protected Enabler user interface on themobile
device. This Enabler functionality, which will be explained in further detail later in this guide, includes:

l Connection toMobile Device Server method
l Connection parameters to theMobile Device Server
l Start-up parameters
l Network andWireless monitoring and control

Avalanche MC Console
The AvalancheMC Console is aWindows desktop application.
It can be run from any location on the network and can be used with multiple Mobile Device Servers as long as there is an IP or
network connection between the PC with the AvalancheMC Console and the PC (or multiple PCs) running theMobile Device
Server service.
The AvalancheMC Console and theMobile Device Server may also be installed on the same PC.
The AvalancheMC Console does not communicate directly with themanaged devices. Instead, the AvalancheMC Console
communicates with theMobile Device Server and theMobile Device Server communicates with themanaged devices.
AvalancheMC Console version 4.2 or greater supports the Avalanche Enablers designed for Honeywell mobile devices.

eXpress Config

eXpress Config can be used to create and configure Honeywell software packages for distribution from the AvalancheMC
Console.
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Avalanche Mobile Device Server
The AvalancheMobile Device Server is installed on a desktop or laptop PC and runs/functions as aWindows service. The
Mobile Device Server starts automatically andmonitors for communications from devices running Avalanche Enablers that are
connected to the same network.
The AvalancheMC Console can connect to or disconnect from theMobile Device Server. Even when the AvalancheMC
Console is not connected to theMobile Device Server, theMobile Device Server continues tomonitor for communications
from the Enablers.

Avalanche Enablers
Avalanche Enablers are installed on the devices to bemonitored. The Enabler maintains a record of the software updates and
configuration parameters on themonitored device. This information is communicated to theMobile Device Server running as a
Windows service on a desktop PC. TheMobile Device Server sends updated software and configuration parameters to the
monitored devices as applicable.
The Enabler performs several functions:

l Reports revision levels of software currently loaded on themonitored device.
l Receives and installs software and configuration updates from theMobile Device Server.
l Prompts the User for reboots as necessary during the installation/configuration process.

Remote Management Utility (RMU)

The Honeywell RemoteManagement Utility (RMU) is installed on all supported Honeywell devices duringmanufacturing.
The RMU maintains records of all Honeywell packages that have been downloaded to the device. The RMU is launched by the
Enabler each time a package is updated.
The RMU performs several functions:

l Identifies and installs Honeywell packages.
l Applies settings for Honeywell packages configured by eXpress Config.
l Removes Honeywell packages that have been deleted by the Enabler.
l Updates real-time properties which are communicated back to theMobility Center Console via theMobile Device

Server.
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Avalanche Remote Control
Avalanche Remote Control is an add-on for AvalancheMC. Remote control provides the administrator the ability to remotely
view themobile device’s desktop and enter data into themobile device.

Device Skins

Device skins work with Avalanche Remote Control for supported Honeywell mobile devices. The skins enable Remote Control
to display an image of the Honeywell mobile device beingmanaged. The skin provides:

l An image of themobile device including the display
l An image of themobile device keypad. Keypresses performed via Remote Control function the same as if the keys

were pressed on themobile device.

eXpress Scan
The eXpress Scan utility allows an administrator to scan bar codes to provide the initial network and AvalancheMobile Device
Server address configuration. This eliminates the need to edit radio parameters manually on themobile device.
eXpress Scan uses bar codes created with eXpress Config.
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Supported Devices and Software
The following Honeywell computers / mobile devices, running the Avalanche Enabler, are supported. They will identify
themselves to the Avalanche Console using the string shown for Model Identifier. Some devices may havemore than one
identifier string depending on software revision or hardware configuration. ReferenceGuides for these devices are available.

HX2

l Microsoft Windows CE 5.0
l Intel® XScale® processor, 400MHz
l Color display, 320 x 240 pixels
l Model Identifier: LXE_HX2

HX3

l Microsoft Windows CE 5.0
l Intel® XScale® processor, 400MHz
l No display, minimal keypad
l Model Identifier: LXE_HX3

MX3Plus

l MX3Plus: Microsoft Windows CE 5.0
l Intel® XScale® processor, 400MHz
l Serial COM port(s) on endcap
l Color display, 640 x 240 pixels
l Model Identifier: LXE_MX3X or LXE_MX3H

MX7 Tecton

l Microsoft Windows CE 6.0 orWindows Mobile 6.5
l Intel® XScale® processor, 806MHz
l Serial COM port on base of device
l Color display, 240 x 320 pixels
l Model Identifier: LXE_MX7T or LXE_MX7TWM

MX7

l Microsoft Windows CE 5.0
l Intel® XScale® processor, 400MHz
l Serial COM port on base of device
l Color display, 240 x 320 pixels
l Model Identifier: LXE_MX7
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MX8

l Microsoft Windows CE 5.0
l Intel® XScale® processor 520MHz
l Serial COM port on base of device
l Color display, 240 x 320 pixels
l Model Identifier: LXE_MX8

MX9

l Microsoft Windows CE 5.0 orWindows Mobile 6.5
l Marvell® PXA-320 processor 806MHz
l Serial COM port on base of device
l Color display, 3.7" (94mm), vertical orientation
l Model Identifier: LXE_MX9 or LXE_MX9WM

Thor VM1

l Microsoft Windows CE 6.0
l Intel® Atom Z530 processor 1.6GHz
l Serial COM ports on Vehicle-Mount Smart Dock
l Color display, 8" (20cm), WVGA (800x480)
l Model Identifier: LXE_THOR

Thor VM2

l Microsoft Windows CE 6.0
l Intel® Atom Z530 processor 1.6GHz
l Serial COM ports on Vehicle-Mount Smart Dock
l Color display, 8" (20cm), SVGA (1024x768)
l Model Identifier: LXE_THOR

VX3Plus

l VX3Plus: Microsoft Windows CE 5.0
l Intel® XScale® processor, 400MHz
l Serial COM port(s) on endcap
l Color display, 640 x 240 pixels
l Model Identifier: LXE_VX3X or LXE_VX3H
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VX6

l Microsoft Windows CE .NET 4.2 or CE 5.0
l Intel® XScale® processor, 400MHz
l Serial COM ports at base of device
l Half screen color display, 800 x 320 pixels
l Model Identifier: LXE_VXC, LXE_VX6 or LXE_VX6SD

VX7

l Microsoft Windows CE .NET 4.2 or CE 5.0
l Intel® XScale® processor, 400MHz
l Serial COM ports at base of device
l Full screen color display, 800 x 600 pixels
l Model Identifier: LXE_VXC, LXE_VX7 or LXE_VX7SD
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Chapter 2  - Enabler Installation and Configuration

Introduction
This section discusses Honeywell supported features withWavelink AvalancheMobile Device Servers. This section is split
into three basic areas:

l Installation
l User Interface
l Enabler Configuration

Installation
To use theWavelink AvalancheMC System, the following items are required:

l A desktop or laptop PC onwhich to install the AvalancheMC Console.
l A desktop or laptop PC onwhich to install the AvalancheMobile Device Server (this can be the same PC where the

AvalancheMC Console is installed).
l Wavelink AvalancheMC Console 4.2 or later.
l AWavelink Device License for each client device.
l Supportedmobile devices with Enablers installed.

To use Avalanche Remote Control, the follow additional items are required:
l Wavelink Remote Control plug-in, 2.0 or later
l AWavelink Remote Control License for each client device

Installing the Enabler on Mobile Devices
Supported devices (listed in the segment titled Supported Devices) have the Avalanche Enabler installation files loaded, but
not installed, on themobile device when it is shipped. The installation files are located in the \System folder onWindows
devices.
Supported devices manufactured before April 2007must have some software components upgraded before they can use the
Avalanche Enabler functions described in this reference guide. Contact Technical Assistance for details on upgrading the
mobile device baseline.
Note: Important: If the user is NOT usingWavelink Avalanche tomanage their mobile device(s), the Enabler should not be

installed on themobile device(s). Doing so results in unnecessary delays when booting the device.
The Avalanche Enabler installation file LXE_ENABLER.CAB is loaded on themobile device by Honeywell; however, the
device is not configured to launch the Enabler installation file automatically. The installation applicationmust be runmanually
the first time Avalanche is used.
Note: Older versions of the Enabler may have a device specific name such as LXE_XXX_ENABLER.CAB.
After installation, the Enabler runs as a background applicationmonitoring for updates. This behavior can bemodified by
accessing the Avalanche Update Settings panel through the Enabler interface.
The RMU.CE.CAB file is placed on the device duringmanufacturing in the \System\RMU folder.
During the Enabler installation process, the Enabler checks for the RMU.CE.CAB file in the \System folder.
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l If present, it assumes the RMU.CE.CAB file is already installed and continues.
l If the file RMU.CE.CAB file is not present, it looks for the file in the \System\RMU folder.
l If present, the Enabler copies the file to the \System folder and installs it.

At this point, the OS will automatically install the RemoteManagement Utility (RMU) after themobile device reboots.

VX6/VX7 Enabler Installation

Because the VX6 and VX7 computers have two possible network adapters (the optional internal adapter for a cabled network
connection and the wireless network card), the Enabler uses the first network adapter it discovers. In order to assure the
Enabler uses the wireless connection, perform one of the following actions:

l Select the Adapters tab in the Enabler setup (See Enabler Configuration) andmake sure the wireless adapter is
selected forCurrent Adapter.

l To disable the internal network adapter, create a file in the \System directory namedNoEther.tag. The contents of the
file are unimportant; but the file must be namedNoEther.tag and it must be in the \System directory. (If the \System
directory contains a file namedEther.tag, you can rename this file to NoEther.tag instead of creating a new file).

l After creating the file, coldboot the device. After the device finishes booting, the internal Ethernet adapter is disabled.
l To restore the adapter, delete the NoEther.tag file and coldboot the device.

Enabler Uninstall Process
To remove the Avalanche Enabler from themobile device:

l Delete the Avalanche folder located in the \System directory.
l Warm boot themobile device.

The Avalanche folder cannot be deleted while the Enabler is running. See Stop the Enabler Service.
If sharing errors occur while attempting to delete the Avalanche folder, warm boot themobile device, immediately delete the
Avalanche folder, and then perform another warm boot.
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Stop the Enabler Service
To stop the Enabler frommonitoring for updates from theMobility Center Console:

1. Open the Enabler Settings Panels by tapping the Enabler icon on themobile device desktop.
2. Select File > Settings.
3. Select theStartup/Shutdown tab.
4. Select theDo not monitor or launch Enabler parameter to prevent automatic monitoring upon startup.
5. Select Stop Monitoring for an immediate shutdown of all Enabler update functionality upon exiting the user interface.
6. Click theOK button to save the changes.
7. Reboot themobile device if necessary.

or
1. Open the Enabler Settings Panels by tapping the Enabler icon on themobile device desktop.
2. Select File > Settings.
3. Select thePreferences tab.
4. Select Do not monitor to prevent automatic monitoring uponStartup.
5. Select Exit Application for an immediate shutdown of all Enabler update functionality upon exiting the user interface.
6. Click theOK button to save the changes.
7. Reboot themobile device if necessary.
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Update Monitoring Overview
There are threemethods by which the Enabler on themobile device can communicate with theMobile Device Server running
on the host machine.

l Wired via a serial cable between theMobile Device Server PC and themobile device.
l Wired via a USB connection, using ActiveSync, between theMobile Device Server PC and themobile device.
l Wirelessly via themobile device 2.4GHz radio and an access point

After installing the Enabler on themobile device the Enabler searches for aMobile Device Server, first by polling all available
serial ports and then over the wireless network.
The Enabler running on themobile device will attempt to access COM1, COM2, and COM3. “Agent not found” will be reported
if theMobile Device Server is not located or a serial port is not present or available (COM port settings can be verified using the
bar code wedge panels on themobile device).
Note: Refer to themobile device ReferenceGuide for communication details as theremay be differences in capabilities.
The wireless connection is made using the default wireless [radio] interface on themobile device therefore themobile device
must be actively communicating with the network for this method to succeed.
If a Mobile Device Server is found, the Enabler automatically attempts to apply all wireless and network settings from the
active profile. The Enabler also automatically downloads and processes all available packages.
If the Enabler does not automatically detect theMobile Device Server, the IP address of theMobile Device Server can be
entered on the Connect tab of the Enabler setup. Please see Enabler Configuration for details.
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Mobile Device Wireless and Network Settings
Once the connection to theMobile Device Server is established, themobile device Enabler attempts to apply all network and
wireless settings contained in the active profile.
The success of the application of settings is dependent upon the local configuration of control parameters for the Enabler.
These local parameters cannot be overridden from the AvalancheMC Console.
The default Enabler adapter control settings are:

l Manage network settings – enabled
l Use Avalanche network profile – enabled
l Manage wireless settings – disabled

To configure the Avalanche Enabler management of the network and wireless settings:
1. Open the Enabler Settings Panels by tapping theEnabler icon on the desktop.
2. Select File > Settings.
3. Select the Adapters tab.
4. Choose settings for theUse Manual Settings parameter.
5. Choose settings forManage Network Settings,Manage Wireless Settings andUse Avalanche Network Profile.
6. Click theOK button to save the changes.
7. Reboot the device.
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Preparing a Device for Remote Management
Two additional utilities are necessary for remotemanagement. These utilities are included onmobile devices manufactured
after April 2007.

l TheRemote Management Utility (RMU)must be installed on all mobile devices first – then you can control mobile
device reboot, storage RAM adjustment, real-time updates and Avalanche Enabler properties.
If in doubt, verify RMU.CE.CAB exists in the \System folder. If the RMU.CE.CAB file is present when the Enabler is
installed, the RMU is also installed.
Important: If the OS package includes double-byte Asian fonts, the storage RAM property of the RMU must be higher
than the default value (40MB).
If the amount of storage RAM is too low, the Enabler returns a “Mobile unit out of resources” error.
To determine theminimum value required, inspect the RMU.StorageRAM>=nn parameter in the Criteria field for the OS
package. Generally, this setting should be approximately 40MB above the amount of RAM in use on the device for a
standard OS and 50MB above the amount of RAM in use for anOS with Asian fonts.
For example, if after installing all the software, the device shows 5MB in use, this setting should be about 45MB for a
standard OS, 55MB for an Asian font OS.

l Use theWireless Configuration Application (WCA)when you want to remotely manage the Summit client device.
This utility is downloaded and installed in addition to the RemoteManagement Utility. TheWCA is included when the
Summit radio driver software is updated. TheWCA is automatically installed when the radio driver is updated.
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Using Wavelink Avalanche to Upgrade System Baseline

This procedure assumes the Avalanche Enabler is already installed on themobile device and is already in communication with
the AvalancheMC Console.

Part 1 – Bootstrapping the RMU

1. Install the RMUCEbt package into the AvalancheMC Console. Do NOT include the Reboot option as part of the
configuration (i.e. theReboot button in the “Reboot Options” branchmust be unbolded).

2. Enable ONLY the RMUCEbt package in the AvalancheMC Console and update the devices. The RMU is downloaded
and automatically installed.

3. Disable the RMUCEbt package in the AvalancheMC Console.
4. For each device, double-click on the device to open the Client Controls dialog box.
5. Check theDelete Orphaned Packages checkbox and click theUpdate Now button.
6. After the sync completes, uncheck Delete Orphaned Packages and close the dialog box.

Part 2 – Installing Packages

1. Enable the RMUCE package in the AvalancheMC Console.
2. Enable all remaining packages and send them down. It is important that you include the new OS package in this group

(be sure to include the Enabler). If the radio is to bemanaged remotely, it is important to include the radio package in this
group so that after the reboot the radio can automatically associate. If the radio package is not sent, the device loses
connection to the network andmanual configuration of the radio parameters is required.

3. Set the Reboot setting for the OS package toAuto.
4. After all packages are downloaded (this may take several minutes) the RemoteManagement Utility (RMU) is launched.

The RMU processes all the downloaded packages. If the radio package was downloaded, theWireless Configuration
Application (WCA) is launched to process the new radio settings.

5. After the RMU finishes installing all the packages, the device is automatically coldbooted (assuming the Reboot setting
was set to Auto in Step 3).

6. After the Device completes the coldboot, the RMU is autoinstalled by the OS and the previously downloaded packages
are restored. Assuming at least one package has registry settings that were restored, and that package was set to
reboot (either auto or prompt), the RMU then performs an automatic warmboot.

7. After the warmboot, the device is configured.
8. If the device will no longer bemonitored by Wavelink Avalanche, youmay remove the Enabler to eliminate boot up

delays, if desired. Even if the Enabler is removed, the installed packages and their configurations continue to be
restored with every reboot by the RMU.

Version Information on Mobile Devices

The VersionInfo.EXE file is included in the RemoteManagement Utility package downloaded to themobile device. It is stored
in the \Program Files\RMU folder. When VersionInfo.EXE is opened, a dialog box is presented to themobile device user
displaying:

l RemoteManagement Utility (RMU) version
l Wireless Configuration Application (WCA) version

VersionInfo displays the version for each utility only after that utility has been executed at least once.
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User Interface
The Enabler can be configured and controlledmanually through the user interface on themobile device. This section details the
functionality that can be controlled by the user or system administrator.
Parameters and Screen Displays
Screen displays shown in this section are designed to present the end-user with information graphically.
Placement of information on the screen displays may be split between one or many tabbed panels.
Standard Avalanche Enabler parameters that are not supported by Honeywell may bemissing or dimmed (visible but unable to
be edited) on the tabbed panels or screen displays.

Enabler Configuration
Depending on the version of the Enabler running on themobile device, the desktop Enabler iconmay look like one of the
following:

The available configuration options and tabs may vary by Enabler version. The examples shown in this section assume the
latest version of the Enabler is installed on themobile device.
The Enabler user interface application is launched by clicking either theEnabler icon on the desktop or Taskbar or by selecting
Avalanche Enabler from the Programs menu.
The opening screen presents themobile device user with the connection status and a navigationmenu.

Note: Some parameters and features described in this sectionmay not be available if you are not running the latest version
of the Enabler. Contact Technical Assistance for upgrades.
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File Menu Options

Connect
The Connect option under the File menu allows the user to initiate amanual connection to theMobile Device
Server. The connectionmethods, by default, are wireless and COM connections. Any updates available will be
applied to themobile device immediately upon a successful connection.

Scan
Config

The Scan Configuration feature is not supported. The Scan Config option under the File menu allows the user to
configure Enabler settings using a special bar code that can be created using the AvalancheMC Console utilities.
Refer to theWavelink AvalancheMobility Center User Guide for details.

Settings

The Settings option under the File menu allows themobile device user to access the control panel to locally
configure the Enabler settings. The Enabler control panel is, by default, password protected.

The default Settings password is system. The password is not case-sensitive.
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Avalanche Update using File > Settings
Use thesemenu options to setup the Avalanche Enabler on themobile device. Change the settings and save them by
rebooting before connecting to the network.
Alternatively, theMobile Device Server can be disabled until needed (refer to theWavelink Avalanche Mobility Center
User’s Guide for details).

Menu Options

Note: Your mobile device screen display may not be exactly as shown in the followingmenu options. Contact Technical
Assistance for version information and upgrade availability.

Connection Enter the IP Address or host name of theMobile Device Server. Set the order in which serial ports or
RF connections are used to check for the presence of theMobile Device Server.

Server Contact Setup synchronization, scheduledMobile Device Server contact, suspend and reboot settings.

Data Control when data is transferred between the device and theMobile Device Server.

Preferences Set options for Enabler startup or shutdown and logging. If the Preferences tab is not present, you
may have an older version of the Enabler with the Startup/Shutdown tab.

Display Set up theWindows display at startup, on connect and during normal mode. The settings can be
adjusted by the user.

Taskbar Set options for Taskbar. If the Taskbar tab is not present, youmay have an older version of the
Enabler with the Startup/Shutdown tab.

Execution Not available in this release. Use AppLock instead, which is resident on each device with the
exception of the HX3.

Scan Config This option allows the user to configure Enabler settings using a special bar code that is created by
the AvalancheMC Console. Scan Config not currently supported.

Shortcuts Add, delete and update shortcuts to user-allowable applications.

SaaS Configure the Enabler to connect with Avalanche on Demand.

Adapters Enable or disable network and wireless settings. Select an adapter and switch between the
Avalanche Network Profile andmanual settings.

Status View the current adapter signal strength and quality, IP address, MAC address, SSID, BSSID and
Link speed. The user cannot edit this information.

Startup/Shutdown Set options for Enabler program startup or shutdown. Replaced by Preferences and Taskbar tabs in
some versions of Enabler.
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Connection

Avalanche
Server Address Enter the IP Address or host name of theMobile Device Server assigned to themobile device.

Check Serial
Connection

Indicates whether the Enabler should first check for serial port connection to theMobile Device Server
before checking for a wireless connection to theMobile Device Server.

Disable
ActiveSync Disable ActiveSync connection with theMobile Device Server.

Restrict
Adapter Link
Speed

Default is disabled. Minimum Link Speed dimmed. When enabled, the Enabler only allows a connection to
the server if the detected link speed is greater than or equal to the specified value.
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Server Contact

Note: Your mobile device screen display may not be exactly as shown above. Contact Technical Assistance for upgrade
availability and version information.

Sync Clock Reset the time on themobile device based on the time on theMobile Device Server host PC.

Contact

l OnStartup – Connect to theMobile Device Server when the Enabler is accessed.
l OnResume –Connect to theMobile Device Server when resuming from Suspendmode.
l On IP Change – Connect to theMobile Device Server when the IP address of themobile

device changes.
l OnExt. Power – Initiate connection to theMobile Device Server when the device is

connected to an external power source, such as based on a docking event.

Contact Periodically /
Periodic Update

Allows the administrator to configure the Enabler to contact theMobile Device Server and query for
updates at a regular interval.

Wakeup device if sus-
pended

If the time interval for periodic contact with theMobile Device Server occurs, amobile device that is
in SuspendMode can wakeup and process updates.

Reboot before attempt Reboot mobile device before attempting to contact Mobile Device Server.

Require external power Only connect when themobile device has external power.

Use relative offset Dimmed.
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Data

The Data tab controls when data is transferred between themobile device and theMobile Device Server.

Real-time Statistics /
Network When checked, the statistics are transmitted over the network by the Enabler.

Report Specifies the Report Interval, how frequently the Enabler reports statistics to theMobile Device
Server.

Retransmit After
Server Contact

Specifies if the device sends statistics to theMobile Device Server immediately following a
connection to the server.

Restrict Bandwidth to
User Idle Time /
Transfer DataWhen
Device is Idle

When enabled, periodic updates from theMobile Device Server are postponed until themobile device
has been idle for the specified period of time. The default is disabled.

Idle timeout Specify the length of time the devicemust be idle before a periodic update can run, used when the
parameter above is enabled.
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Preferences

For best results, useAppLock to manage the taskbar. AppLock is resident on eachmobile device, with the exception of the
HX3. AppLock configuration instructions are located in each equipment-specific reference guide.
If the Preferences tab is not present on the Enabler installed on your device, please see the equivalent options on the
Startup/Shutdown tab.

Administration

By default, Keep settings unlocked for 10minutes is disabled (checkbox is blank).

Application

Startup

Behavior of the Enabler when themobile device boots up. The default is Monitor for Updates.
l Do not Monitor -When the device boots, do not launch the Enabler application and do not attempt to

connect to theMobile Device Server.
l Monitor for Updates - Attempt to connect to theMobile Device Server and process any updates that are

available. Do not launch the Enabler application.
l Launch User Interface - Attempt to connect to theMobile Device Server and process any updates that are

available. Launch the Enabler application.

Shutdown

Behavior of themonitor when the Enabler is exited. The default is Monitor for Updates.
l Monitor for Updates - Attempt to connect to theMobile Device Server and process any updates that are

available. Do not launch the Enabler application.
l Exit Application - Terminates themonitor (requires successful password entry if a password has been

configured).
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Activity Log

Log Level

Use this option to control the level of detail recorded in the log file. The default is No Activity Log.
l NoActivity Log - No log file is written.
l Critical - Only critical errors written to the log files.
l Error - Communication or configuration problems are written to the log file along with critical

messages.
l Warning - Possible operation problems are written to the log file along with critical and error messages.
l Info - Operational information is written to the log file.
l Debug - Themost detailed log file.

Display Level

Use this option to control the level of detail shown on themain Enabler screen. The default is Basic Output.
l Basic Output - General information is displayed.
l Critical - Critical errors are displayed in addition to those above.
l Error - Communication or configuration problems are displayed in addition to those above.
l Warning - Possible operation problems are displayed in addition to those above.
l Info - Operational information is displayed in addition to those above.
l Debug - Themost detailed list is displayed.
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Display

Update Window Display

The user interface for the Enabler can be configured to dynamically change based on the status of themobile device
connection with theMobile Device Server.

At startup Default is Half Screen. Options are Half screen, Hidden or Full screen.

On connect Default is As Is. Options are As is, Half screen, or Full screen.

Normal Default is As Is. Options are Half screen, Hidden or As Is.
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Taskbar

For best results, useAppLock to manage the taskbar. AppLock is resident on eachmobile device, with the exception of the
HX3. AppLock configuration instructions are located in each equipment-specific reference guide.
If the Taskbar tab is not present on the Enabler installed on your device, please see the equivalent options on the
Startup/Shutdown tab.

The Display State options control the appearance of the taskbar while using the Enabler interface.
l Normal - taskbar is visible, taskbar icons function normally.
l Hidden - taskbar is not displayed
l Locked - taskbar is visible, but most icons are hidden or for information only.
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Execution

Note the dimmed options on this mobile device panel. This menu option is designed tomanage downloaded applications for
automatic execution upon startup.

Auto-Execute
Selection

An application that has been installed with the AvalancheManagement system can be run
automatically following each boot.

Select
Auto-Execute
App

The drop-down box provides a list of applications that have been installed with the Avalanche
Management System.

Delay before
execution Time delay before launching Auto-Execute application.
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Scan Config

For best results, use eXpress Config and eXpress Scan for this function. eXpress Scan is included with the updatedmobile
device enablers.

Scan Config functionality is a standard option of theWavelink AvalancheMC system but is not currently supported on the
mobile device.
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Shortcuts

For best results, useAppLock for this function. AppLock is resident on eachmobile device, with the exception of the HX3.
AppLock configuration instructions are located in each equipment-specific reference guide.

Configure shortcuts to other applications on themobile device. Shortcuts are viewed and activated in the Programs panel. This
limits the user’s access to certain applications when the Enabler is controlling themobile device display.
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SaaS

Use to configure the Enabler to connect with Avalanche on Demand. This is a Software-as-a-Service version of Avalanche.
Using either of the SaaS configuration options below assumes the user has registered withWavelink.

Disable SaaS No SaaS connection is used.

Scan Configure
SaaS

Scan bar codes printed from within the Avalanche Console to configure the Enabler for the SaaS
connection.

Manually
Configure SaaS

Manually enter the SaaS connection information. Enter the server address on the Connection tab and the
customer ID in the Company textbox.
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Adapters

Note: Review the network settings configuration utilities and the default values in themobile device ReferenceGuide before
setting All Adapters to Enable in the Adapters applet.

Manage
Network
Settings

When enabled, the Enabler will control the network settings. This parameter cannot be configured from the
AvalancheMobility Center Console and is enabled by default.

Manage
Wireless
Settings

When enabled, the Enabler will control the wireless settings. This parameter cannot be configured from the
AvalancheMobility Center Console and is disabled by default. For Summit clients, ManageWireless Settings
should not be checked as configuration packages providemore radio configuration options.

Current
Adapter Lists all network adapters currently installed on themobile device. See special instructions for VX6 and VX7 .

Primary
Adapter

Indicates if the Enabler is to attempt to configure the primary adapter (active only if there aremultiple network
adapters).

Icon on
taskbar

Places the Avalanche icon in the Avalanche taskbar that may, optionally, override the standardWindows
taskbar.

Use
Avalanche
Network
Profile

The Enabler will apply all network settings sent to it by theMobile Device Server.

Avalanche Selecting the Avalanche Icon will access the Avalanche Network Profile tab which will display current network
settings.
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Icon
(varies by
Enabler
version)

Use
Manual
Settings

When enabled, the Enabler will ignore any network or wireless settings coming from the AvalancheMC Console
and use only the network settings on themobile device.

Properties
Icon

Selecting the Properties icon displays theManual Settings Properties dialog applet. From here, the user can
configure Network, DNS andWireless parameters using the displays shown below:

Note: A reboot may be required after enabling or disabling these options.

Network DNS
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Authentication Wireless

Note: The Authentication tabmay not be present in all versions of the Enabler.
Formobile device descriptions of these Enabler parameters, refer to themobile device ReferenceGuide.
It is not recommend to enable “ManageWireless Settings” for Summit Client devices.
Note: When you download a profile that is configured tomanage network and wireless settings, the Enabler will not apply

themanage network and wireless settings to the adapter unless the global Manage wireless settings andManage
network settings options are enabled on the Adapters panel (see Figure titled Adapters Options – Network, earlier in
this section). Until these options are enabled, the network and wireless settings are controlled by the third-party
software associated with these settings.
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Status

The Status panel displays the current status of themobile device network adapter selected in the drop down box. Note the
availability of theWindows standard Refresh button.
When theWindows Refresh button is tapped, the signal strength, signal quality and link speed are refreshed for the currently
selected adapter. It also searches for new adapters andmay cause a slight delay to refresh the contents of the drop-down
menu.

Link speed indicates the speed at which the signal is being sent from the adapter to themobile device. Speed is dependent on
signal strength.
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Startup/Shutdown

For best results, useAppLock to manage the taskbar. AppLock is resident on eachmobile device, with the exception of the
HX3. AppLock configuration instructions are located in each equipment-specific reference guide.
If the Startup/Shutdown tab is not present on the Enabler installed on your device, please see the equivalent options on the
Preferences tab and the Taskbar tab.

Do not monitor or launch
Enabler

When the device boots, do not launch the Enabler application and do not attempt to connect to
theMobile Device Server.

Monitor for updates Attempt to connect to theMobile Device Server and process any updates that are available.
Do not launch the Enabler application.

Monitor and launch Enabler Attempt to connect to theMobile Device Server and process any updates that are available.
Launch the Enabler application.

Manage Taskbar (Lock or
Hide)

Note the dimmed options. The Enabler can restrict user access to other applications when the
user interface is accessed by either locking or hiding the taskbar.

Program Shutdown
(Continue or Stop
monitoring)

The system administrator can control whether the Enabler continues tomonitor theMobile
Device Server for updates once the Enabler application is exited.
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Exit

The Exit option is password protected. The default password is leave. The password is not case-sensitive.

Depending on the behavior chosen for the Shutdown parameter, the following screenmay be displayed:

Note: The icon on the screen abovemay differ based on the version of the Enabler installed on themobile device.
Change the option if desired. Tap the X button to cancel Exit. Tap the OK button to exit the Avalanche applet.

Using Remote Management
1. Configure the radio to connect to the network running theMobile Device Server. After themobile device is connected,

proceed to step 2.
2. If it is desired to configure the radio using the Summit package, add the configured package to theWavelink Avalanche

MC Console and enable it.
3. Verify RMU.CE.CAB exists in the \System\RMU folder.
4. Double click themobile device enabler CAB file in the \System folder.
5. The enabler automatically launches after installation and contacts theMobile Device Server. The AvalancheMC

Console connected to that Mobile Device Server identifies the remote device and performs a sync. This downloads any
available packages available for themobile device.
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Using eXpress Scan

eXpress Scan Desktop Icon

If themobile device has an eXpress Scan icon on the desktop, eXpress Scanmay be used for the initial configuration of the
device.
If the eXpress Scan icon is not present on the desktop, install the Enabler. If the icon is still not present, the Enabler must be
updated.
If the eXpress Scan icon is present, follow these steps to configure themobile device to connect with the wireless network and
theMobile Device Server.

Step 1: Create Bar Codes
Bar codes are created with the eXpress Config utility on the desktop/laptop computer, not themobile device. Depending on the
bar code length and the number of parameters selected, eXpress Config generates one or more bar codes for device
configuration. The bar codes contain configuration parameters for the wireless client in themobile device andmay also specify
the address of theMobile Device Server.
Bar codes should be printed at aminimum of 600 dpi.
Please see Creating Configuration Bar Codes with eXpress Config.

Step 2: Scan Bar Codes
For eachmobile device to be configured, please follow these instructions.
Start eXpress Scan on themobile device by double-tapping the eXpress Scan icon.
Enter the bar code password, if any.

Click Start.
Bar code 1must be scanned first. The scanned data is displayed in the “Data” text box. The password, if any, entered above is
compared to the password entered when the bar codes were created.
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If the passwords match, the bar code data is processed and the screen is updated to reflect the number of bar codes included
in the set.
If the passwords do not match, an error message is displayed. The current screen can be closed using theX box in the upper
right corner. The password can be re-entered and Bar Code 1 scanned again.

The remaining bar codes may be scanned in any order. After a bar code is scanned, that bar code is removed from the
Remaining: list and placed in theScanned: list.
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Step 3: Process Completion
After the last bar code is scanned, the settings are automatically applied.

Once configured, themobile device is warmbooted. Once connected to the wireless network and theMobile Device Server,
any software updates and additional configuration data are downloaded.
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Chapter 3  - Avalanche Mobility Center Console

Introduction
This section provides an overview of the AvalancheMC Console when it is being used tomanage Honeywell mobile devices
on a network. Online help (an Internet connection is required to access online help) is available using the Help option in the
ConsoleMainMenu.
The AvalancheMobility Center Console does not communicate directly with themanaged devices. Instead, theMobility
Center Console communicates with theMobile Device Server and theMobile Device Server communicates with themonitored
devices.

l AvalancheMobility Center Console and the AvalancheMobile Device Server run on a desktop PC.
l Avalanche Enabler runs on themonitored device.
l The Enabler communicates with theMobile Device Server.
l Avalanche Remote Control is an optional plug-in for AvalancheMobility Center. Remote Control includes both a

console portion and a software package to be downloaded to themonitored devices.
For detailed and technical information for the AvalancheMobility Center Console running on a desktop PC, refer to the
Wavelink Avalanche Mobility Center User’s Guide. This document is available for download from theWavelink website,
www.wavelink.com. It is not included in this reference guide.
Note: Screenshots in this section are taken from the AvalancheMobility Center Console Version 4.2.

Installation
Minimum requirements for the AvalancheMobility Center server installation (whenmanaging 1000 devices or less) are:

l Microsoft Windows 2000 Professional (SP4), Windows Server 2000 (SP4), Windows Server 2003 (SP1 or later) or
Microsoft Windows XP (SP2 or later) operating system.

l Intel Pentium 4 Processor at 2.8GHz (or equivalent)
l 2GB free disk space (plus an additional 5MB for Avalanche Remote Control if desired)

The optimal requirements for the AvalancheMC server depend on a number of factors, such as the number of Servers and
devices you want to manage and your overall network setup. Please refer to theWavelink AvalancheMobility Center User’s
Guide, available on www.wavelink.com for more details. For more information on Avalanche Remote Control, please refer to
Avalanche Remote Control andWavelink Remote Control User’s Guide (available at www.wavelink.com).
Reminder:When theMobile Device Server sends an update to amobile device Enabler, the Enabler acknowledges receipt
back to theMobile Device Server.
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Avalanche Mobility Center Console Components
There aremany components to the AvalancheMobility Center Console. This section covers the areas specific to the
Honeywell mobile devices and their interaction with the AvalancheMC Console. For complete details on general Avalanche
MC operation, please see theAvalanche Mobility Center User’s Guide, available on www.wavelink.com.
Specific items in this section include:

l Software Profiles
l Network Profiles
l Mobile Device Inventory andMobile Device Groups
l Mobile Device Details

This section assumes:
l The user has set up themobile devices to connect to the network and they meet theminimum software load

requirements mentioned elsewhere in this manual.
l The user has installed AvalancheMC and set up aMobile Device Server as described in the AvalancheMobility Center

User’s Guide.
The AvalancheMC Console Navigationmenu appears as shown below. In this example, a dServer location namedMydServer
has been created.
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Software Profiles
A Software Profile contains one or more Software Packages (.AVA files). To create an .AVA file from a softwaremodule,
please see Creating a Software Package with eXpress Config.
Click onSoftware Profiles in the AvalancheMC Console Navigation pane.
The Software Profile List is displayed in the upper right hand portion of the screen.

Use theAdd Profile button to create a new Software Profile.
When prompted, enter a name for the profile as desired. In the example above, the Software Profile is namedRFTerm test.
After the profile has been created, information on the profile is displayed including the Name, Status (Disabled or Enabled) and
Selection Criteria.
To add a Software Package to the profile, make sure the desired Software Profile is highlighted and click on theSoftware
Packages tab, below.

Several options are available.
The Install button allows the user to browse to and select a Software Package. Browse to the location where the .AVA files
created with eXpress Config are located. Once a package is selected, it appears in the list.
TheConfigure button launches eXpress Config when a supported software package is selected. For more details on these
features and the available options for each type of software, please refer to Configuring a Software Package with eXpress
Config.
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Additionally, if a software package contains Summit radio software, the Configure button offers the user a choice of
configuration options:

l eXpress Config – Config: Use this option to configure a software package to be downloaded to the device via the
connection to aMobile Device Server.

l eXpress Config – Barcodes: Use this option to create bar codes containing the radio configuration parameters and
Mobile Device Server address. These bar codes can be scanned by themobile computer. The configuration data
contained in the bar codes allows the device to connect to the network andMobile Device Server for additional software
and configuration parameters.

TheEnable / Disable button allows the user to enable or disable this Software Package for download as part of the Software
Profile.
Information on the Software Package includes the Name, Status (Disabled or Enabled), Type, etc. All Honeywell packages are
Auto Run. This package type automatically executes following a successful download to themobile device. It does not modify
the Application (or Programs)menu in themobile device.
When finished, click on theGeneral Settings tab and enable the Software Profile.
Click on theSave icon in the toolbar to save changes to the Software Profile.
Next, select My Enterprise > MydServer (substitute the name of your dServer location). Click on theSoftware Profiles tab in
the lower part of the screen. Add the Software Profile created above.
Click on Tools > Deploy Now using the toolbar at the top of the screen.
The Software Profile is ready to be downloaded:

l Automatically at the next reboot of themobile device
l Manually by selecting the device from theMobile Device Inventory list and clicking Update Now.
l At a scheduled time
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Network Profiles
Click on Network Profiles in the AvalancheMC Console Navigation pane.
The Network Profile List is displayed in the upper right hand portion of the screen.

Use theAdd Profile button to create a new Network Profile. When prompted, enter a name for the profile as desired. In the
example above, the Network Profile is named test. After the profile has been created, information about the profile is displayed
including the Name, SSID, Security, Status (Disabled or Enabled) and Selection Criteria.
Wireless and network parameters are set as part of a Network Profile. To enablemanagement of these settings, make sure the
desiredNetwork Profile is highlighted and click on theGeneral Settings tab.

Click the Manage Network Settings checkbox to allow AvalancheMC tomanage network settings on themobile devices as
part of this network profile.
Click theManage Wireless Settings checkbox to allow AvalancheMC tomanage wireless settings on themobile device as
part of this network profile.
Set Network andWireless settings as described in the following sections.
Click on theSave icon in the toolbar to save changes to the Network Profile.
When finished, click on theGeneral Settings tab and enable the Network Profile.
Next, select My Enterprise > MydServer (substitute the name of your dServer location).
Click on theNetwork Profiles tab in the lower part of the screen. Add theSoftware Profile created above.
Click on Tools > Deploy Now using the toolbar at the top of the screen.
The Network Profile is ready to be downloaded:

l Automatically at the next reboot of themobile device
l Manually by selecting the device from theMobile Device Inventory list and clicking Update Now.
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l At a scheduled time

Network Settings

When aNetwork Profile is selected, click on the Network Settings tab to see available parameters.

The network settings include:
l Server Address –When checked, this option allows themobile device to be linked to a specific Mobile Device Server.

When not used, the device links to the first Mobile Device Server that responds to the broadcast.
l Gateway – The router address. To use the router address of the current Mobile Device Server, enable the UseMobile

Device Server Setting checkbox.
l Subnet Mask – The subnet mask in IP address format. To use the subnet mask of the current Mobile Device Server,

enable the UseMobile Device Server Setting checkbox.
l Default DNS Domain – The default DNS domain.
l Primary DNS – The IP address of the primary DNS.
l Secondary DNS – The IP address of the secondary DNS.
l Tertiary DNS – The IP address of the tertiary (third in line) DNS.
l IP Address Assignment – Provides options for assigning an IP Address:

l Manual Assignment – No IP address is assigned by AvalancheMC. IP address must be set on the device.
Review theWireless Network Configuration chapter in the appropriate equipment-specific reference guide.

l Avalanche Pool – Avalanche allows a range of IP addresses to be specified. If this option is used, an IP
address is assigned from that range.

l DHCP – A DHCP server is contacted for an IP address.
When finished, complete the process as detailed in Network Profiles, previously in this section.

Mobile Device Inventory

When amobile device running an Enabler contacts theMobile Device Server, themobile device is added to theMobile Device
Inventory.
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To view theMobile Device Inventory, select My Enterprise > MydServer (substitute the name of your dServer location) >
Mobile Device Server. Click on theMobile Device Inventory tab.

Eachmobile device includes identifying information such as model name, IP address andMAC address. Additional information
includes the status and time or date of last contact.
A check mark indicates a device is up to date, an X indicates a device is not up to date.
For more information on the Status icons, please refer to theWavelink Avalanche Mobility Center User’s Guide.

Mobile Device Groups
It may be desirable to createMobile Device Groups whenmanaging a large number of devices. To create aMobile Device
Group, right click onMobile Device Group in the Navigation pane. Select New and assign a name to the group.
Complete the entries as desired for the group.

Mobile Device Details
Anytime a device is listed in theMobile Device Inventory or theMobile Device Group screen, details on the devicemay be
displayed by double clicking on the device.
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Of particular interest for the Honeywell mobile devices are the RMU properties:
l FreeSpaceAvailable – Formore information please see Space Requirements onMobile Computers .
l StorageRAM – Formore information please see Preparing a Device for RemoteManagement .
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Chapter 4  - eXpress Config

Introduction
eXpress Config is installed on a desktop/laptop computer with aWindows XP operating system. It is an accessory product to
theWavelink AvalancheMC systemmanagement application. The desktop/laptop computer running theWavelink Avalanche
MC systemmanagement application is, for the purposes of this document, described as the Avalanche MC Console.
Software Packages distributed to theMobile Device Servers and Enablers do not include the eXpress Config application.
eXpress Config provides three basic functions:

l eXpress Config can be used to create software packages for Honeywell software. [See Creating a Software Package
with eXpress Config]

l eXpress Config can be used to configure the software packages, either when the package is created or after the
package has been imported into the AvalancheMC console. [See Configuring a Software Package with eXpress
Config]

l eXpress Config can be used to generate and print bar codes to be used with the eXpress Scan feature installed on
certain Honeywell devices. The bar codes generated using eXpress Scan are designed for the initial wireless network
andMobile Device Server configuration on themobile device. [See Creating Configuration Bar Codes with eXpress
Config]

See: Supported Devices and Software.
The assumption is made that the user has a basic familiarity with Microsoft Windows terms, basic Windows components and
their use/function. For example, assumption is made that the user is familiar with the operation of Windows Title Bars, Menu
Bars, Navigation Trees, Configuration Panels, andMessage Panels. The final assumption is that the user has access to
standardWindows Help vehicles: on-line Help, Windows Help documents, etc. available fromMicrosoft and on-line help or
documentation available fromWavelink.
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Avalanche Software Collections
Software collections aremade up of one or more Software Packages. Software Packages are created using eXpress Config.
Software Packages created using eXpress Config include a softwaremodule and parameter configuration information.
Honeywell softwaremodules compatible with eXpress Config include a data definition file (.DDF) which communicates the
configurable parameters for that particular softwaremodule to eXpress Config. The DDF file was not included in earlier
Avalanche software packages.
TheWavelink Package Builder can be used to send non-Honeywell supported software, if desired.
A network administrator interacts with the Avalanche Console to define policies and create software collections that are
distributed through the AvalancheMobile Device Servers to the Avalanche Enablers running on client devices.
When a Software Package is installed into the AvalancheMC Console, it becomes available for inclusion in a Software
Collection. eXpress Config is launched by clicking the Configure tab, after selecting a Software Package that has been
installed in the Avalanche Console and included in a Software Collection. eXpress Config reads the data definition file which is
included in the software package and presents the configurable parameters for that Software Package to the device
administrator through a graphical user interface.
Once the device administrator has updated the configurable parameters, the new parameter values are included in the
Software Package.
The device administrator also defines policies that are assigned to each Software Collection. These policies determine which
client device receives the software collection.
Note: Honeywell softwaremodules include operating systemmodules, an RFTermmodule, an AppLock module, a bar code

wedgemodule or a radio module. Softwaremodules are sometimes also referred to as “G-numbers” or “P-numbers”.
The type of softwaremodules available vary depending on the operating system of themanaged device

Space Requirements on Mobile Computers
Theremust be sufficient space on themobile device when downloading software collections.

l Themobile devicemust have aminimum of 128MB CF card.
l The free space on the CF cardmust be at least twice the size of the largest file in the package.
l The RMU creates a real-time property called RMU.FreeSpaceAvailable which can be read from the AvalancheMC

Console. To view this property, right-click on a device in the AvalancheMC Console and click Mobile Device
Settings…. Select the Properties tab. The RMU.FreeSpaceAvailable property is included in the list of properties only
after the RMU has executed at least one time on the remote device and the Enabler has successfully synchronized with
the AvalancheMC Console.
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Installation
The installer program places eXpress Config on a desktop/laptop computer runningWindows XP. The computer requires the
.NET Framework Version 2.0 be available before the software package can complete the installation.

Prerequisites

l .NET Framework installer fromMicrosoft downloaded and installed on the Avalanche Console device.
Note: The installation program verifies that .NET Framework Version 2.0 is installed. If the .NET framework is not installed,

the eXpress Config software does not install.

Install eXpress Config
1. Double-click the eXpressConfigSetupWizard link. TheWizard screen opens.

The installer will guide you through the steps required to install eXpress Config on your computer.
Click Next to continue. Click Cancel at any time to abort the installation and exit.

2. Select the Installation folder.
The default Installation folder is either
For 32-bit computers: \Program Files\Honeywell\eXpress Config (version) e.g.: eXpress Config 1Bb, or
For 64-bit computers: \Program Files (x86)\Honeywell\eXpress Config (version) e.g.: eXpress Config 1Bb.
If needed, browse to a different folder location or enter the path and name for the preferred folder.
Select (the current version of the) eXpress Config user access permission. The default is Everyone.
Click Back to return to the previous display orNext to continue. ClickCancel at any time to abort the installation and
exit.

3. Click Next to start the installation.
During installation a shortcut to eXpress Config is created on the desktop. A shortcut is placed in the Start Menu under
Programs>Honeywell.
Click Back to return to the previous display. Click Cancel to abort the installation and exit.

4. Click Close to exit the installation utility when the installation is complete.
5. Double-click the eXpress Config icon on the desktop or inStart > Programs > Honeywell to launch eXpress Config.

The eXpress Config Package Selection screen is displayed.
Please see sections titled Creating a Software Package with eXpress Config and Configuring a Software Package with
eXpress Config for explanations of the screen display objects that may be presented to the user.

Uninstall eXpress Config

Start > Control Panel > Add or Remove Programs

Depending on the version installed, select either eXpress Config version or Package Builder version e.g. Package Builder 0Ab,
1Ab, etc., in theCurrently Installed Programs list to uninstall eXpress Config.
Click theChange/Remove button.
Select Remove and follow the prompts on the screen.
The eXpress Config program is removed from the desktop/laptop computer. The .NET Framework is not removed.
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Creating a Software Package with eXpress Config

eXpress Config Icon on PC or Laptop Desktop

Prerequisites:

l Honeywell softwaremodule package, per device type.
l A decision on whether to include configuration data only [See Package Selection Screen]

When including an operating system package, it is important to also include a radio package so that after the reboot
the radio can automatically associate. If the radio package is not sent, the device loses connection to the network and
manual configuration of the radio parameters is required.

Process Overview
Prerequisite: RemoteManagement Utility (RMU) that includes eXpress Scan is installed on the target device. Devices
manufactured after October 2007 already include this updated RMU as part of the system load. Installation of the RMU is
detailed in Preparing a Device for RemoteManagement.

1. Download the softwaremodule from Honeywell.
2. Run eXpress Config by double-clicking the eXpress Config icon on the desktop or inStart > Programs > Honeywell.
3. Browse to the location of the downloaded software.
4. Specify a destination to store the package that is created.
5. If desired, click theConfigure Package button to configure the parameters. Otherwise, the default values are used.

a. To send parameters only (no software is to be installed) check the Include Configuration Only
checkbox.

b. Review parameters in the Navigation Tree. [See Navigation Tree]
c. Left click a parameter to expand the element. [See Controls]
d. Left click a sub-element. [See Controls]
e. Edit the parameter values in the Configuration Panel. [See Configuration Panel]
f. Save changes and exit. [SeeMenu Bar]

6. Click OK to create the package. Depending on the options selected, the package includes configuration parameters,
software or both parameters and software.

7. Using an AvalancheMobile Device Server with the package installed, download the package to the target mobile device
enabled. See User Interface.

8. Verify the RemoteManagement Utility is installed on the target device. See Preparing a Device for Remote
Management.
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Important Note for Software Packages Containing an Operating System
If the software package contains anOperating System (OS)module, the OS in the software packagemust be the same type
as the OS currently installed on themobile device.

l If themobile device is using CE 4.2, then the OS in the packagemust also be CE 4.2. Avalanche cannot be used to
upgrade amobile device from CE 4.2 to CE 5.0 or to downgrade a device from CE 5.0 to CE 4.2.

l Avalanche cannot be used to replace a standard (no Java) OS with anOS containing Java or to replace anOS
containing Java with a standard OS.

l Avalanche cannot be used to change theOS font installed on the device. Both the device andOS module to be
downloadedmust have the same font (English, Korean, Japanese, etc.).

If the radio is to bemanaged remotely, it is important to include the radio package in this group so that after the reboot
the radio can automatically associate. If the radio package is not sent, the device loses connection to the network and
manual configuration of the radio parameters is required.

Package Selection Screen
The eXpress Config Package Selection screen is displayed:

The user may create directories as desired for the G-Number and Destination locations. Create these directories before using
eXpress Config.
Browse to the folder location of the source softwaremodule file and select the desired file for the package that will be created.
If the package can be configured for multiple devices, eXpress Config displays a list of available devices. Select the
appropriate device and press the Accept button to proceed.
Browse to the folder for the destination location. The destination folder contains the package after it is built.
TheConfigure Barcodes… button is only present when the software package contains Summit radio software. Use the
Configure Barcodes… button to create configuration bar codes to be used for the initial configuration of amobile device. Please
see Creating Configuration Bar Codes with eXpress Config for details on this feature.
Use theConfigure Package… button to create a custom configuration for the package being built. The configuration
parameters are applied to the package file when theOK button is clicked. If Cancel is selected, the configuration is lost. The
Configure Package button is disabled if there is no .DDF file in the softwaremodule directory.
Enable the Include Configuration Only checkbox when you want to include configuration data only. The softwaremodule is
not included in the package created when this control is checked.
Click OK to create the package file in the specified folder or Cancel to abort the operation and close the program.
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Updating Many Devices With The Same Configuration
1. Update a single mobile devicewith the new configuration and verify all functions perform as expected on the target

device.
2. If all functions do not perform as expected,make changes to the configuration, if necessary, and update a single

mobile device. Verify all functions perform as expected.
3. Proceed to update all mobile devices with the verified configuration.

Procedure for Removing Package Files on the Remote Device
1. Right-click on amonitored device in theWavelink AvalancheMC Console and select Client Settings.
2. Check Delete Orphaned Packages checkbox.
3. Click theUpdate Now button.
4. The next time theRMU runs, it will remove the packages from the device.

Note: Operating System packages and the RMU itself can only be removed from themonitored devicemanually.
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Configuring a Software Package with eXpress Config
eXpress Config provides a configuration interface for the software provided in each SoftwareModule Package. When one of
these packages is opened in the AvalancheMC Console, it is eXpress Config which is launched. eXpress Config presents a
user interface for providing configuration data for the softwaremodule also bundled in that package – and only that software.
For example, if a Package contains the RFTermmodule, eXpress Config, when launched from that package, presents only
configuration parameters relevant to RFTerm.
Only Honeywell softwaremodules that include a Package file (PKG) and Data Definition File (DDF) can be configured with
eXpress Config. Since Data Definition Files are a requirement for this software, that means softwaremodules released prior to
the release of eXpress Config are not configurable using eXpress Config.
When a package is “opened” – that is, eXpress Config is launched – eXpress Config displays all configuration parameters
described in the Data Definition File (and a REG file if included). The first time a package is configured, default values for all
parameters are presented. Changes to the parameters are saved back to the package. Every subsequent time the package is
configured, the last saved configuration data is presented. All parameter changes are saved to the package, but only ‘marked’
data is sent to the remote device. Parameter values modified by the user are automatically marked. The user may change the
‘marked’ status of any parameter or group of parameters. eXpress Config can also be opened from the AvalancheMC Console,
and in this casemarked data values are sent to the devices and are saved to the package within the AvalancheMC Console.
Launch eXpress Config through the AvalancheMC Console by right clicking on the softwaremodule package name and select
Configure Package on the right click menu. Then select eXpress Config from the Configure Packagemenu.
Theremay be two eXpress Config entries, depending on the currently selected software package.

l eXpress Config – Config is present for all software packages and is the option covered in this section.
l Additionally, eXpress Config – Barcodes is present for some Summit radio software packages. Please see Creating

Configuration Bar Codes with eXpress Config for details on this process.

Menu Bar
Alt key shortcuts are available for theMenu Bar. For example, pressing the <Alt><F> key combination will cause the ‘File’
menu bar drop-down to be displayed. When a drop-downmenu is displayed, pressing the key corresponding to the underlined
letter in any menu item causes that menu item to be invoked.
TheMenu Bar contains twomenu items: File and Edit.
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File Menu

Save

Causes the current configuration parameters to be written to the embedded ‘ini’ file. This includes all parameters for
the active software package, not just visible parameters. There are no additional user interface elements displayed
when ‘Save’ is selected. A Save confirmation dialog box is presented to the user. Buttons on the Save dialog have the
following functions:

l Yes – Causes configuration changes to be saved to the software package, and the configuration utility to
close.

l No –Causes the configuration utility to close without saving unsaved changes.
l Cancel – Causes the configuration dialog to close, but leaves the configuration utility open. User control stays

with the configuration utility. Unsaved configuration changes are not saved.

About Displays a dialog containing the version number of the configuration utility and a copyright notice. Click the OK button
or the X to close the dialog box and return to the configuration utility.

Exit

The function of the Exit option is to exit the configuration function:
l If eXpress Config was accessed from the AvalancheMC Console, selecting Exit returns you to Avalanche.
l If the Configure Package button was clicked on the Package Selection screen, selecting Exit returns you to

the Package Selection screen.

Edit Menu

The Edit menu bar drop-down contains three items: Cut, Copy and Paste. These three items have the standardWindows
functionality of cutting, copying and pasting selected text in user editable fields.

Navigation Tree
A navigation treemay havemultiple root nodes. The organization of the navigation treemirrors the navigation of the program
being configured.
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Controls

At the left most position in each entry is a control to expand or contract the subordinate tree elements. The control can be
toggled from [ + ] to [ - ] with a left mouse click.
Next is a check box that indicates if parameters in that branch of the tree are selected for inclusion in the software package.
The check box has three states:

Checked This state indicates that all parameters in the tree branch are selected for inclusion in the software package.

Unchecked (Blank) This state indicates that none of the parameters in the tree branch are selected for inclusion in the
software package.

Mixed (Dimmed checkmark) This state indicates that some parameters in the tree branch are selected for inclusion in
the software package and some parameters are not included.

Left click a leaf in the expanded branch to display the parameters associated with the leaf to be displayed in the Configuration
panel.
Right click a label or associated check box to display a Selection panel. The selection panel contains three choices:

Select All Causes the check box to transition to the Checked state. The parameters will be included in the software
package.

Unselect All Causes the check box to transition to the Unchecked state. The parameters will not be included in the
software package.

Reset To
Defaults

Causes default values to be applied to all parameters in that branch and sub-branches. Default parameters will
be included in the software package.

Each check box transition is propagated both upward and downward through the navigation tree, and to the individual
parameters in the configuration panel.

Root Nodes

Reboot Options

Indicates whether the client device is to be rebooted when the new package is installed. Rebooting the client after installing the
package is the surest way to cause new parameters and software to be applied immediately. However, rebooting the device
may disrupt any end-user operations in progress.

Default Prompt

Options
Auto - Causes the device to automatically reboot (user is not prompted).
Prompt - Causes the Enabler to display a prompt asking if the device is to be rebooted immediately, or if the reboot
should be delayed. ‘Prompt’ is the default value.

If no reboot is desired, do not include the reboot options parameter in the package.

Data File Options

The element label is derived from the specific application configurationmenu.
There is always a root node named after the data file (without the file extension), for example ‘rfterm’. Packages that require a
reboot for configuration changes to become effective include a Reboot Options node at the root level (see above).
The branches or leaves on the navigation tree lead to user-configurable parameters. See Configuration Panel for instruction.
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Configuration Panel
The Configuration Panel is designed to allow the device administrator to view, add, edit and delete device-specific or
application-specific configuration data.
Parameters and elements displayed in the Configuration Panel are the same as those displayed on themobile device. Only
parameters and elements with an editable attribute set to True are available for edit. If a parameter or element is dimmed, it
cannot be edited. There are visual and navigationmodifications due to differences between the application environment
(Windows CE orWindows Mobile) and the Configuration Panel environment (assumed to beWindows XP), and because of
differences in navigation between the target application and the configuration utility.

The lower portion of the screen contains details on the selected parameter whichmay include the default value for the
parameter, parameter descriptions, etc.

Controls

When aControl is selected, the Control’s context-sensitive help text is displayed in theMessage Panel.

Scroll Bar Use the up/down scroll bar to view elements listed in the configuration panel

Drop Down Bar Click the down arrow to view all possible element values. Highlight and click the desired value.

Text/Number Edit Move the cursor to the data entry field and type the desired value.

Toggle Click the button to switch between the named states e.g. Yes/No, On/Off, etc.
Review all parameters before saving the file.
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Component Parameters
Note: Available parameters may vary by software version.

Software Component Configurable Parameters

Operating Systems

Only parameters associated with the following control panel applets. (Applets may have different
names or parameters than these listed below.)

l Scanner (Data CollectionWedge or BarcodeWedge)
l Display (backlight and blanking)
l Power

All parameters in each of these applets are configurable. In general, this means that, in addition to
theWedge configuration, powermanagement, display backlight and display blanking are
configurable.
See the device specific ReferenceGuide.
Equipment Specific Notes:

l Note that some Battery panels may include some reporting and diagnostic capabilities.
These diagnostic and reporting capabilities are not implemented through eXpress Config.

RFTerm

All parameters except:
l Keybars
l Bar code stripping (note that similar functionality is supported in the Data Collection

Wedge and ScannerWedge)
l Windows Printer config (note that theWindows Printer config is also not included in the

OS configuration.)
l Font color

See the RFTerm ReferenceGuide for a full list of parameters for the target device.

AppLock All parameters. See the device specific ReferenceGuide.

Scanner (Bar Code
Wedge) or Data
Collection
(DC Wedge)

All parameters. See the device specific ReferenceGuide.
Scanner Prefix and Suffix Note:

l Note that the Prefix and Suffix entry field accepts up to 76 characters to allow a
combination of normal, hat encoded and hex characters. However, the Suffix and Prefix
are each limited to 19 logical characters after parsing. If the string entered results in more
than 19 logical characters, the string is truncated to 19 characters. No warning or error
message is provided if the result is truncated.

Enabler None.
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Software Component Configurable Parameters

Summit Client

The following Summit wireless parameters are included:

l Active Profile
l Profile Name
l SSID
l Client Name
l Power Save
l TX Power
l Bit Rate
l RadioMode
l Authentication Type
l EAP Type
l Encryption
l User Name
l User Password
l CA Filename

l RX Diversity
l WEP Key 1-4
l Transmit Key
l PSK
l TX Diversity
l Roam Trigger
l Roam Delta
l Roam Period
l Ping Payload
l Ping Timeout
l Ping Delay
l LED
l Hide Password
l Admin Override

l Auth Server
l Admin Password
l Frag Threshold
l Certs Path
l CCX Features
l WMM
l TTLS Inner Method
l PNK Caching
l BGChannel Set
l DFS Channels
l DFS Scan Time
l AdHoc Channel
l Tray Icon
l Auth Timeout

Additionally:
l The RMU can be used to install user certificates into the certificate store on themobile

device. The certificate must already be on the device.
l User credentials can be created and remotely managed using eXpress Config.

See the device specific ReferenceGuide for details on the Summit parameters.
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Creating Configuration Bar Codes with eXpress Config
When a software package contains Summit radio software, eXpress Config can be used to create bar codes to configure the
basic parameters that allow amobile device to connect with the wireless network and theMobile Device Server. The
configuration screens appear similar to those for any other Honeywell software package, as described in the previous section,
but with some notable differences:

l TheConfigure Barcodes… button is only present when the software package is for Summit radio software. The
Configure Barcodes… button is not present for Summit software revisions released prior to the eXpress Scan feature.

l This option only provides configuration data. No software is downloaded to themobile device. However, once the
configuration bar codes are used to configure themobile device to contact the wireless network andMobile Device
Server, software upgrades can then be performed.

l WhenConfigure Barcodes… is selected, the parameters available for configuration differ from the parameters
available when Configure Package… is selected.

l TheMenu bar includes aBarcode > Print option.
Launch eXpress Config through the AvalancheMC Console by right clicking on the softwaremodule package name and
select Configure Package on the right click menu. Then select eXpress Config – Barcodes from the Configure Package
menu.
If eXpress Config – Barcodes is not present, one or more of the following applies:

l The software package is not a Summit radio package.
l The Summit radio package does not meet theminimum revision requirements.
l eXpress Config does not meet theminimum revision requirements.

Note: Contact Technical Assistance for upgrade availability andminimum revision requirements.
Theremay be two eXpress Config entries, depending on the currently selected software package.

l eXpress Config – Barcodes is present for some Summit radio software packages and is the option covered in this
section.

l eXpress Config – Config is present for all software packages and is the option covered in Configuring a Software
Package with eXpress Config.

It is not necessary to save the configuration parameters before printing the bar codes.
If Save is selected, the saved parameters become part of the software package and are sent if the software package is
deployed in the AvalancheMC Console. If Save is not selected, the bar codes can be printed, but the software package, if
deployed, does not contain the configuration data included in the bar codes.

Process Overview
Prerequisite: RemoteManagement Utility (RMU) that includes eXpress Scan is installed on the target device. Devices
manufactured after October 2007 already include this updated RMU as part of the system load. Installation of the RMU is
detailed inPreparing aMobile Device for RemoteManagement.

1. Download the softwaremodule from Honeywell.
2. Run eXpress Config by double-clicking the eXpress Config icon on the desktop or inStart > Programs > Honeywell.
3. Browse to the location of the software for theSummit radio.
4. Specify a destination to store the package that is created.
5. Click theConfigure Barcodes button to configure the parameters.

a. Review parameters in the Navigation Tree. [See Navigation Tree]
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b. Left click a parameter to expand the element. [See Controls]
c. Left click a sub-element. [See Controls]
d. Edit the parameter values in the Configuration Panel. [See Configuration Panel]
e. Save changes. [SeeMenu Bar]
f. Print the bar codes and exit [SeeMenu Bar]

6. On amobile device with eXpress Scan installed (as part of the Enabler installation), click on the eXpress Scan icon.
7. Enter the password, if any, used when the bar codes were created.
8. Scan Barcode 1 first. The password, if any, is verified against the password used when the bar code was created.

After the first bar code is scanned, the remaining bar codes may be scanned in any order.
9. After the final bar code is scanned, the settings are applied to themobile device and it automatically reboots.
10. After it reboots and connects to theMobile Device Server, any additional configuration parameters and software

packages are downloaded to themobile device.
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Menu Bar
Alt key shortcuts are available for theMenu Bar. For example, pressing the <Alt><F> key combination will cause the ‘File’
menu bar drop-down to be displayed. When a drop-downmenu is displayed, pressing the key corresponding to the underlined
letter in any menu item causes that menu item to be invoked.
TheMenu Bar contains threemenu items: File, Edit and Barcodes.

File Menu

Save

Causes the current configuration parameters to be written to the embedded ‘ini’ file. This includes all parameters for
the active software package, not just visible parameters. There are no additional user interface elements displayed
when ‘Save’ is selected. A Save confirmation dialog box is presented to the user. Buttons on the Save dialog have the
following functions:

l Yes – Causes configuration changes to be saved to the software package, and the configuration utility to
close.

l No –Causes the configuration utility to close without saving unsaved changes.
l Cancel – Causes the configuration dialog to close, but leaves the configuration utility open. User control stays

with the configuration utility. Unsaved configuration changes are not saved.

About Displays a dialog containing the version number of the configuration utility and a copyright notice. Click the OK button
or the X to close the dialog box and return to the configuration utility.

Exit

The function of the Exit option is to exit the configuration function:
l If eXpress Config was accessed from the AvalancheMC Console, selecting Exit returns you to Avalanche.
l If the Configure Package button was clicked on the Package Selection screen, selecting Exit returns you to

the Package Selection screen.

Edit Menu

The Edit menu bar drop-down contains three items: Cut, Copy and Paste. These three items have the standardWindows
functionality of cutting, copying and pasting selected text in user editable fields.
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Barcodes Menu

The Barcodemenu contains one item, Print…. When selected, a standardWindows print dialog box is displayed, allowing for
selection of a printer, pages to be printed and the number of copies.

Bar codes should be printed at aminimum of 600 dpi. Additional printer properties can be accessed by clicking theProperties
orPreferences button. Click the ? button for built inWindows help on the printer or printer properties/preferences.
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The above bar codes are provided for reference only and should not be used for device configuration. The actual bar codes
generated depend on the configuration parameters selected and the values entered for those parameters.
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Navigation Tree
The navigation tree has limited nodes when Configure Barcodes… has been selected.

Controls

At the left most position in each entry is a control to expand or contract the subordinate tree elements. The control can be
toggled from [ + ] to [ - ] with a left mouse click.
Next is a check box that indicates if parameters in that branch of the tree are selected for inclusion in the software package.
The check box has three states:

Checked This state indicates that all parameters in the tree branch are selected for inclusion in the software package.

Unchecked (Blank) This state indicates that none of the parameters in the tree branch are selected for inclusion in the
software package.

Mixed (Dimmed checkmark) This state indicates that some parameters in the tree branch are selected for inclusion in
the software package and some parameters are not included.

Left click a leaf in the expanded branch to display the parameters associated with the leaf to be displayed in the Configuration
panel.
Right click a label or associated check box to display a Selection panel. The selection panel contains three choices:

Select All Causes the check box to transition to the Checked state. The parameters will be included in the software
package.

Unselect All Causes the check box to transition to the Unchecked state. The parameters will not be included in the
software package.

Reset To
Defaults

Causes default values to be applied to all parameters in that branch and sub-branches. Default parameters will
be included in the software package.

Each check box transition is propagated both upward and downward through the navigation tree, and to the individual
parameters in the configuration panel.
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Root Nodes

Data File Options

The element label is derived from the specific application configurationmenu. In this case, the node is always WLAN.
The branches or leaves on the navigation tree lead to user-configurable parameters. See Configuration Panel for instruction.

Configuration Panel
The Configuration Panel is designed to allow the device administrator to view, add, edit and delete wireless network specific
configuration data.
Parameters and elements displayed in the Configuration Panel are limited to those necessary for basic wireless network
configuration.

The lower portion of the screen contains details on the selected parameter whichmay include the default value for the
parameter, parameter descriptions, etc.
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Controls

When aControl is selected, the Control’s context-sensitive help text is displayed in theMessage Panel.

Scroll Bar Use the up/down scroll bar to view elements listed in the configuration panel

Drop Down Bar Click the down arrow to view all possible element values. Highlight and click the desired value.

Text/Number Edit Move the cursor to the data entry field and type the desired value.

Toggle Click the button to switch between the named states e.g. Yes/No, On/Off, etc.
Review all parameters before saving the file printing bar codes.
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Component Parameters
Note: Available parameters may vary by software version.

Software Component Configurable Parameters

Barcode Settings

Contains parameters for bar code generation
l Passcode – Determines if a password is included in the bar codes. If a password is

specified, the user must enter the passcode on themobile device in order to process the
scanned configuration bar codes.

l Change… –Specifies the passcode to be used. The passcodemust be entered and
confirmed.

If the passwords don’t match, an error message is displayed. To assign the password, click
Accept.

l Barcode Length – Determines the width of the bar code. Valid values are from 30 to 100.
The default is 40. Barcode length should be set according to the capacity of the internal,
tethered, Bluetooth or ring scanner used with themobile device.

Network Settings

The following network parameters are included:

l Wavelink Server Address
l UseDHCP
l Static IP Address
l Subnet Mask
l Gateway

l Primary DNS
l Secondary DNS
l Primary WINS
l Secondary WINS

For details on theWavelink Server Address, please refer to Connection tab in Enabler
Configuration.
For all other parameters, see the device specific ReferenceGuide or refer toWindows on line help.
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Software Component Configurable Parameters

Wireless Settings

The following Summit wireless parameters are included:

l Profile Name
l SSID
l Client Name
l Authentication Type
l EAP Type
l Encryption

l User Name
l User Password
l CA Filename
l WEP Key 1-4
l Transmit Key
l PSK

For details on these parameters, see the device specific ReferenceGuide.

Global Settings

The following Summit wireless parameters are included:

l Admin Override
l Certs Path

l CCX Features
l WMM

For details on these parameters, see the device specific ReferenceGuide.
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Chapter 5  - Avalanche Remote Control

Introduction
This section provides an overview of the Avalanche Remote Control v2.0 plug-in for AvalancheMobility Center AvalancheMC
Console. Version 3.0 is not currently supported.
When using Remote Control, the keyboard on the AvalancheManagement Console PC can be used to enter alphanumeric
characters for the remote device.
For detailed and technical information for the Avalanche Remote Control plug-in, refer to theWavelink Remote Control User’s
Guide. This document is available for download from theWavelink website, www.wavelink.com. It is not included in this
reference guide.

Supported Devices
Avalanche Remote Control is supported for the following devices:

l HX2 (CE 5.0)
l HX3 (CE 5.0)
l MX3Plus (CE 5.0)
l MX3X (CE .NET or CE 5.0) [Device obsolete Dec 2009]
l MX7 (CE 5.0)
l MX7 Tecton (CE 6.0)
l MX8 (CE 5.0)
l MX9 (CE 5.0)
l VX3Plus (CE 5.0)
l VX3X (CE 5.0) [Device obsolete Dec 2009]
l VX6 (CE .NET or CE 5.0)
l VX7 (CE .NET or CE 5.0)

Installation
Avalanche Remote Control is installed as a software package into the AvalancheMC Console. Once installed and enabled,
the client portion of Remote Control is distributed to themanaged devices. The process is highlighted below. For more
information on the process, please see AvalancheMobility Center Console, and theWavelink Remote Control User’s Guide
available at www.wavelink.com

1. Create a software profile. To create a software profile, click onSoftware Profiles in the Navigation pane. Then click the
Add Profile button. Assign a name to the software profile.

2. Enable the software profile. Make sure theStatus is set to Enabled on theGeneral Settings tab for the profile.
3. Install the software package. Click on theSoftware Packages tab. Click the Install button and browse to theAVA file

forWavelink Remote Control.
4. Configure the software package.
5. Enable the software package so it can be distributed to themanaged devices.

For more information, please refer toWavelink Remote Control User’s Guide, available from www.wavelink.com.
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Remote Control Console
The Remote Control Console is accessed via the Configure button for the Remote Control software package.

Skins
The first step in the configuration process is to download the applicable skin for themanaged device. If more than one type of
device is managed, download a skin for each type of device. Once the skins are downloaded, the appropriate skin for the
managed device is automatically selected.
To download the skin, locate theRemote Control software package. Select the package and click theConfigure button.
Select KeyMap Editor from the pulldown list and click OK.
From the KeyMap editor, select Skin > Download From Web.
When the Skins Download box appears, click Connect or OK to connect to the skin download center.
A list of skins available for download is displayed. When selecting a skin, it is necessary tomake sure both the device type and
keypad style match your device. For example, theMX7 is available with a 32-key keypad and a 55-key keypad. Be sure to
select the skin that matches the device’s keypad configuration.
Select the desired skin and click OK.
Only one skin can be downloaded at a time. If multiple skins for different devices are required, download the first skin then
repeat for the additional skins.
When the download is complete, the new skin is displayed in the keymap editor.
When finished, exit the keymap editor.
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Adding a Device to Remote Control
Note: Additional procedures are included in theWavelink Remote Control user’s Guide.
From theRemote Control console, click on theProfiles tab.

Assign a name to the profile.
Make sure theConnection Type is properly set (usually TCPIP).
Scale should be set to 1x for hand-held or wearable Honeywell devices. For vehicle-mount Honeywell devices, .5x should be
selected.
Click Update to save the profile.
To add the device, click on theMobileDevices tab.
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Select the desired profile from theProfile listing.
Specify the IP address of the desired device.
Click Connect to connect to the device.
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Themobile device skin is displayed. If the proper skin is downloaded for amobile device, that skin is automatically displayed.
Please note, some devices (like theMX7) havemore than one skin because there is more than one keypad configuration. See
the following section (Selecting an Alternative Skin) for information on changing the skin.
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For information on other features of Remote Control, such as the file explorer, logging, creating screen captures, etc. please
refer to theWavelink Remote Control User’s Guide.
To disconnect, select File > Exit.
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Selecting an Alternative Skin
If the skin automatically displayed is correct for your keypad configuration, youmay skip these steps.
If connected to a device, click File > Exit to disconnect from the device and return to the Remote Control console.
From the Remote Control console, click on theProfiles tab.

Select the appropriate profile. The profile namewas assigned in Step 2 of Adding a Device to Remote Control .
Use theShow Skin pulldown list to select the appropriate skin for your device.
Click theUpdate button to save the changes.
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Remote Control Keypad Limitations
The following limitations apply to all Honeywell managed devices. Please see the device specific limitation sections that
follow.

l The skin provides a visual indication of the keypress.
l Remote Control sends an F24 keypress to the remote device every few seconds to keep the device awake.

All Devices
The following limitations apply to all supported computers.

1. The following controls are not supported:
l Keypad volume controls. The Control Panel Volume & Sounds can be used by the remote operator to control the

volume.
l Backlight controls.
l Contrast controls.
l Scan keys.
l Power button.
l Suspend/Resume controls.

2. Blue Diamond and any other programmable keys must be configured in the skin by the local administrator to match
whatever the setting for that key is on the device. Refer to the Keymap Editor section of theWavelink Remote Control
User’s Guide for details. Likewise if any custom keymapping is done on themobile device using the KeyPad utility, this
custommappingmust be configured in the skin as well for the skin to generate the remapped keypress.

3. The remote console CapsLock state is entered by sending a “Capital” keystroke to themobile device. This state is
indicated on the device by a blue “A” in the task bar. There is no separate CapsLock state in the skin.

4. Generally Alt, Ctrl, and Shift can be combined in any order on both the device and the remote console. However, on the
remote console, the states shown in the status bars will be “Alt-Ctrl”, “Alt-Shift”, “Ctrl-Shift”, and “Alt-Ctrl-Shift”,
regardless of the actual order in which themodifier keys were pressed. That is, “Alt-Ctrl” and “Ctrl-Alt” achieve the same
result on the device.

5. The skin returns to the Normal state after a sequence of keypresses unless the state has been defined as sticky. If the
state is sticky, the skin does not return to Normal mode after the functional keypress. If the skin is in a sticky state, it is
necessary to press themodifier keys that created the sticky state to undo the sticky state.
For example, if the Ctrl-Shift state is sticky, press <Ctrl> + <Shift> to cancel the sticky state.
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HX2 Dual Alpha

1. The default mode for the numeric keys is to produce numeric characters, and this mode is labeled “Normal” in the skin.

HX2 Triple Tap

1. The default mode for the numeric keys is to produce numeric characters, and this mode is labeled “Normal” in the skin.
2. On the physical device, pressing the Blue key puts the device in Alphamode somultiple clicks of the numeric keys

generate the alpha characters. In the skin, the Blue key is a sticky key because Remote Control would otherwise revert
to Numeric after the first <Blue> + <numeric key> keypress.
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HX2 Legacy

1. The default mode is for the numeric keys to produce numeric characters. This mode is labeled “Normal” in the skin.
2. When the keyboard is in Alphamode, the remote keypad only provides the alpha values of the keypress. For example,

on the physical HX2 keypad, when Alphamode is enabled, pressing the 2 key multiple times cycles from A to B to C to
2. On the remote keypad, only A B and C are supported. To generate a numeric keypress, return to Normal mode.

3. The device and the skin do not operate identically with respect to toggling between the Numeric, Alpha Lower, and
Alpha Upper state. The table below shows the key presses necessary to transition from one state to the other on the
HX2.

Physical Keypad

The table below shows how the physical HX2 keypad cycles between states (numeric, alpha lower and alpha upper).
Note: To switch from Alpha Upper to Numeric, youmust switch from Alpha Upper to Alpha Lower (Orange key) then from

Alpha Lower to Numeric (Orange key).

Current HX2
Keypad State

Desired HX2 Keypad State

Numeric Alpha Lower Alpha Upper

Numeric <Orange> <Orange> <Orange>

Alpha Lower <Orange> <Orange> <Orange>

Alpha Upper SeeNote above <Orange>

Remote Control Keypad

The skin has only the Numeric and Alpha states. The Alpha state can switch between upper and lowermodes by sending the
Capital keystroke as described below. The first press of the Orange key transitions the HX2 from Numeric to Alpha. Once in
Alphamode, pressing the Orange key sends the Capital keystroke which switches the device’s keyboard between lower case
and upper case. Clicking <Blue> <Orange> the Alpha state returns the keypad to Numeric.
Note: To switch from Numeric to Alpha Upper, youmust switch from Numeric to Alpha Lower (<Orange> key) then from

Alpha Lower to Alpha Upper (<Orange> key).

Current HX2
Keypad State

Desired HX2 Keypad State

Numeric Alpha Lower Alpha Upper

Numeric <Orange> See Note above

Alpha Lower <Blue> <Orange> <Orange>

Alpha Upper <Blue> <Orange> <Orange>

5-10



HX3

1. The Blue button is not supported in the remote console because its function is to control volume, which is not directly
supported by remote control. Instead the control panel applet must be used to remotely change volume.
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MX7-55

MX7 Tecton 55-Key MX7 55-Key
1. On the physical keypad, the following key combinations generate no output:

<Shift> + <Tab >
<Shift> + <Enter>
<Shift> + <Del>
<Shift> + <Spc>
<Shift> + <1>

In the skin, the second keypress is ignored and stays in the Shift state.
2. TheMX7-55 is the default skin for anMX7 andMX7 Tecton. A user must manually select theMX7-32 skin for anMX7 or

MX7 Tecton with a 32-key keypad. Failure to select the proper skin may cause unintended results.
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MX7-32

MX7 Tecton 32-Key MX7 32-Key
1. TheMX7-55 is the default skin for anMX7 andMX7 Tecton. A user must manually select theMX7-32 skin for anMX7

andMX7 Tecton with a 32-key keypad.
Failure to select the proper skin may cause unintended results.

2. When in Alphamode, <Blue> + <Tab> sends the CapsLock keystroke. On the physical keypad, theMX7 andMX7
Tecton is put into CapsLock mode with the state displayed in the task bar. TheMX7 andMX7 Tecton remains in Alpha
mode. However, on the remote console the state drops back to NumLock because Remote Control returns a device to
the default state, not the previous state, after amodifier key is used.

3. Similarly, in Alphamode using the Blue or Orangemodifier keys causes the remote console to drop back to NumLock
(the default state) whereas on the physical keyboard theMX7 (and Tecton) would remain in the Alpha state.

4. On the physical keypad, <Shift> + <Orange> + <char> locks the keyboard. On remote control, <Shift> + <Blue> or
<Orange> is not allowed.
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MX8

32 Key Numeric with Triple-Tap Alpha 32 Key Alpha-Mode Numeric
Note: TheMX8 skin only supports theMX8with 32 Key Numeric with Triple-Tap Alpha keypad. It DOES NOT support the

MX8with 32 Key Alpha-Mode Numeric keypad.
1. In the Alphamode in the remote control, all Alt/Ctrl/Shift states are sticky in order to allow themulti-click of the number

keys. The states are not actually stick on the device.
2. The default state is Numeric.
3. <Alt> + <Ctrl> + <Del> does not reboot the device. Instead it brings up the Task Manager.
4. <Alt / Ctrl / Shift> + <Blue / Orange> is a valid state. <Blue / Orange> + <Alt / Ctrl / Shift> is not.
5. On the physical keypad, <Ctrl> + <Shift> does not equal <Shift> + <Ctrl>. The former behaves as one would expect,

while the other resolves to nomodifier at all.
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VX6

1. The VX6 does not support a NumLock off state. Therefore the <2nd> + <Shift> + <F10> keypress has no effect either
on the physical keypad or the remote console.

2. On the physical keyboard, <2nd> + <Shift> + <F8> or <F9> incorrectly creates a Shift state. The remote console
correctly creates Right-Alt and Right-Ctrl states respectively.

3. Warning: <2nd> + <Alt> + <Ctrl> + < . > is Control-Alt-Delete. This sequence reboots the computer, causing the
network connection to be at least temporarily broken.
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VX7 60-key Standard Keypad (Small QWERTY)

1. Normal state is NumLock. NumOff state is NumLock Off. Toggle between Normal and NumLock with <2nd> + <Shift>
+ <F10>. The alpha and function keys behavior is unchanged.

2. The NumLock state is not visible from the VX7 screen. The NumLock state in the remote console is independent of the
device state, so that the actual keyboard state does not interfere with the commands sent from the remote console.

3. In non-NumLock state, using amodifier key returns the remote console to NumLock state, while on the device it would
stay in non-NumLock state.

4. On the device, once amodifier key is clicked it cannot be “unclicked” by clicking it again. Themodifier state will not
clear until a functional key is pressed. The remote control skin follows this behavior. The exception is the 2nd key, which
can be toggled on and off. However, the 2nd key must be clicked first, and not after any other modifier key (except for
Alt).

5. Warning: <2nd> + <Alt> + <Ctrl> + < . > is Control-Alt-Delete. This sequence reboots the computer, causing the
network connection to be at least temporarily broken.

6. In NumLock mode, <2nd> + <Alt> state is different from <Alt> + <2nd>. The former is equivalent to <2nd> while the
latter is a unique state. In NumLock Off mode, there is no <Alt> + <2nd> and that key sequence results in the <2nd>
state.

5-16



VX7 95-key Keyboard (Large QWERTY)

1. The following are not supported:
l Windows Key
l Menu Key
l Mouse
l Fn key

2. Normal state is NumLock. NumOff state is NumLock Off. The alpha and function keys behavior is independent of the
NumLock state.

3. The NumLock state is not visible from the VX7 screen. The NumLock state in the remote console is independent of the
device state, so that the actual keyboard state does not interfere with the commands sent from the remote console.

4. In non-NumLock state, using amodifier key returns the remote console to NumLock state, while on the device it would
stay in non-NumLock state.

5. On the device, themodifier keys are not sticky, i.e. the user must hold them down until a functional key is hit. At the
remote console, themodifier keys are necessarily sticky. Clicking on amodifier key and then clicking it again will return
the device to its previous state, equivalent to releasing the key on the actual device.

6. To switch between NumLock and NumLock-Off modes, the NumLock buttonmust be clicked first. Once another
modifier key has been pressed, it is not possible to switch between NumLock modes.

7. Warning: <2nd> + <Alt> + <Ctrl> + < . > is Control-Alt-Delete. This sequence reboots the computer, causing the
network connection to be at least temporarily broken.
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Chapter 6  - Technical Assistance

If you need assistance installing or troubleshooting your device, please contact us by using one of themethods below:
Knowledge Base:www.hsmknowledgebase.com
Our Knowledge Base provides thousands of immediate solutions. If the Knowledge Base cannot help, our Technical Support
Portal (see below) provides an easy way to report your problem or ask your question.
Technical Support Portal:www.hsmsupportportal.com
The Technical Support Portal not only allows you to report your problem, but it also provides immediate solutions to your
technical issues by searching our Knowledge Base. With the Portal, you can submit and track your questions online and send
and receive attachments.
Web form:www.hsmcontactsupport.com
You can contact our technical support team directly by filling out our online support form. Enter your contact details and the
description of the question/problem.
Telephone:www.honeywellaidc.com/locations
For our latest contact information, please check our website at the link above.

Product Service and Repair
Honeywell International Inc. provides service for all of its products through service centers throughout the world. To obtain
warranty or non-warranty service, please visit www.honeywellaidc.com and select Support > Contact Service and Repair
to see your region’s instructions on how to obtain a ReturnMaterial Authorization number (RMA #). You should do this prior to
returning the product.
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